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Ioan Dumitrescu continues our Custom Brushes for Sci-Fi tutorial.  
wseries.
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Min Yum shows us how to paint his deceivingly peaceful looking Siren in 
the third part of our Creatures from Folklore series.
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Editorial 
November will always be 

known for its fireworks 

and explosive excitement, 

well the November issue 

of 2dArtist is no exception. 

We will start by having 

a quick overview of this 

month’s interview which is 

with the amazing Ignacio 

Bazan Lazcano. Ignacio 

is a regular contributor 

to the magazine, and I 

am sure many of you have been blown away by some of his fantastic 

images, but in this month’s issue we go a step further and learn a 

little about the man behind the art. Ignacio has had a really interesting 

route into the CG industry, even to the extent that his first job involved 

creating concepts with crayons on paper! 

Many of you will bee familiar with this month’s Making Of artist 

Gediminas Pranckevičius (that isn’t a spelling error, but a very bad 

joke!). There was a real buzz (really I have to stop!) in our forums about 

his amazing image Wasp Woman Returns, so we thought we would get 

him to show us how he created it. 3D was used heavily as a base to 

create a scene in perfect perspective and Gediminas shows us how he 

used this base to create an image with a real sting in it.

This month’s cover image is by a really great artist, who is constantly 

churning out great image after great image at the moment Min Yum. 

Min continues our Painting Creatures form Folklore series by dealing 

with a Siren. The final image is a real treat, and Min does a great job 

with the tutorial to, so this is a must read!

This month we have a brand new series which gets off to a brilliant 

start, Portraiture. Creating portraits is a common subject in any form 

of art so we thought we would show you how to paint a portrait from a 

Photograph, without doing a paintover. The one and only Daarken kicks 

off the series with a fantastic self portrait, and shows us how to tweak an 

image to ensure you have the correct shape, without having to re-paint 

anything.

Our Concept Art for Games series has been a real master class in 

concept art so far, so as we move onto accessories we thought we 

would invite another big hitter in the field of concept art to show us 

through to the end of the series. Craig Sellars takes on the task of 

Chapter 01 | Male | Mike Lim (Daarken)

“When you have a live 
subject you can see exactly 
how the light interacts with 

the planes of their face”

Portraits are one of the most commonly tackled subjects in all forms of art, but also one of the most common that we see 
go horribly wrong. In this series our talented artists will be showing us how to use a photo reference to paint an accurate 
portrait without being tempted to do a paintover. We don’t stop there though; we also venture into the specialized field 

of caricatures. Caricatures are a tricky subject to deal with, but there are ways that you can use your photo reference to 
make them easier and this series gives us an insight into this process.
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“When it is time to draw 
or paint I put on music 
to help my creativity; the 
music choice is dictated 
by what idea or subject I 
have to illustrate”

Many of you will be familiar with this month’s interviewed artist as he has featured in our magazines on many occasions, and been a great source of 

advice for us with his amazing tutorials. Ignacio Bazan Lazcano tells us a bit about his first job in the CG industry and how he likes to balance his time 

between digital painting, traditional painting and having fun!

“Whatever we take from 
the environment should be 
replaced or something new 
added in a positive way to 
balance everything out.”

Share One planet is a global art competition organized to promote the necessity to take more care of the earth and its inhabitants. In this interview the 

organizers catch up with poster designer Adrian Smith who talks about the necessity to care for the earth and the process in creating his work.

This month’s sketchbook brings us something a little different, as it is not just the work of one 
artist but of a whole art studio! Black Volta work as a close team to create great concepts; one 
artist does the sketching, another will play with it and refine it, a third will add color... I think you 

will agree that it will be really interesting to look into their processes!

“Perspective accuracy 
in 3D or any other 
theoretical tool is just 
a shortcut to create the 
necessary illusions to sell 
any 2D fantasy art”

This month we feature:

Kashubo Ivan

Serge Birault

Othniel King

Gediminas Pranckevicius

Tiago da Silva

Rafael Nascimento

Steve Sampson

Branko Bistrovic

Yap Jia Xing

Keun-ju Kim

Concept art for computer games is a fascinating field and an industry that a lot of aspiring digital artists would love to be involved with. This 

tutorial series has been written by some of the biggest and best names in the gaming industry, who will guide us through the way they would 

tackle the three main areas where concept work is required: environments, characters and accessories. The artists involved in this series have 

created a games brief themselves and are free to create their own vision of the description. They will reflect on the steps they choose to take 

from the point of receiving the brief up until they have created a completed concept for their required section.

Chapter 5: Accessories | Craig Sellars 

Intro Text

Custom brushes are not only a great way to increase the speed at which a painting can be completed, but can also create an effect that would 

otherwise be impossible. They can be used in many different types of scene, but many would argue that they become most useful when 

creating a space scene. In space many items need replicating or reproducing in vast quantities, which can be difficult, but custom brushes can 

make this process much easier and simpler. In this series the artists involved will be showing you how to create brushes to improve your scene 

and how to use them to the best effect.

– Free Brushes

Chapter 01:  Asteroid Belt | July 2010

Chapter 02:  Egyptian Sci - Fi Scene | August 2010

Chapter 03:  Night-Time Sci-Fi City Battle | September 2010

Chapter 04:  Underground Corridor | October 2010

Chapter 05:  Sci-Fi Ruins | November 2010

Chapter 06:  Underwater City | December 2010

Fantasy plays a huge part in digital art. It influences thousands of 

artists from around the world and has become a large part of the film 

and gaming industry. So much of what we see within this genre is 

drawn from fairy tales and folklore. In this tutorial series our artists will 

be showing us how to research creatures from folklore and use this 

gathered information to create an original and accurate depiction of 

these fantasy characters.

Chapter 1: September Issue | Goblin | Andrei Pervukhin 
Chapter 2: This Issue | Fairy | Nykolai Aleksander 
Chapter 3: November Issue 59 | Siren | Min Yum 
Chapter 4: December Issue 60 | Ogre | Richard Tilbury 
Chapter 5: January Issue 61 | Troll | Simon Dominic Brewer

Some of you may have seen this great Gediminas Pranckevičius image in the July issue of 2DArtist. 

Well in this issue we get a sneak peek into the processes used to create this quirky image. Gediminas 

uses a 3D base to create a lot of his scene which works really well to show depth and perspective.

“I spent a lot of time trying 
to find the correct path and 
almost everything evolved 

in separate pieces”
– Free Brushes

With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some ex-

clusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-colour, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Portrait of 
Nathan” 
by Jason Seiler
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creating vehicles to navigate the harsh terrain of the volatile prison planet, 

and sets the ball rolling with a prison transport vehicle. 

Custom Brushes for Sci-Fi moves from the realms of space to an 

underwater environment this month as Ioan Dumitrescu shows us how to 

create brushes for an underwater sci-fi scene. Ioan has been a busy guy 

this month as he has been working hard to set up Behind the Iron Curtain, 

but he still found time to share some great tips with us!

This issue is brimming with great work and this is no exception in the 

galleries and Sketchbook. Concept art group Blakvolta show us some of 

their sketches, and the gallery features work from Serge Birault, Branko 

Bistrovic, Kashubo Ivan and Keun–ju Kim. 

This is a real fire cracker of an issue!

http://www.2dartistmag.com


Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display; 

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.
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Ignacio 
Bazan Lazcano 
Lives in the beautiful city of 

Buenos Aires where he has 

been working for four years 

in the games industry as an 

illustrator and concept artist. He currently works 

for TimeGate Studios where his tasks include 

developing the aesthetics of the game right from the 

very beginning. In the future he’d like for Argentina 

to become well-known for its artistic talent, where he 

can learn – and teach – amongst the best.  

http://www.ignaciobazanart.com/

i.bazanlazcano@gmail.com

Gediminas  
Pranckevicius
Born in Panevėžys, Northern 

Lithuania Gediminas lived 

with his family until he had 

completed his studies at 

high school. Being highly interested in fresco art 

Gediminas left his family behind to study fresco 

studies at the Vilnius Academy of Art. Gediminas 

spent 6 years studying intensively but it paid off as 

he now works freelance. 

 

http://www.gedomenas.com/

gediminaspr@gmail.com

ContributorsContributors

Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out a bit more about them! 

If you would like to be a part of 3DCreative or 2DArtist magazine, please 

contact: simon@3dtotal.com

Mike  
Lim (Daarken)

After graduating from the 

Academy of Art University in 

San Francisco with a BFA in 

traditional illustration, Daarken 

began his career by freelancing with several game 

companies such as Wizards of the Coast, Fantasy 

Flight Games, Widescreen Games, Digital Extremes, 

and Upperdeck. He also taught a digital illustration 

workshop at the Academy until 2007, when he 

moved to Virginia.  

http://daarken.com/ 

daarkenart@daarken.com

Would You Like To Contribute To 
3DCreative Or 2DArtist Magazines?
We are always looking for tutorial artists, gallery submissions, potential 

interviewees, ‘making of’ writers, and more. For more information, please 

send a link to your work to: simon@3dtotal.com

Craig   
Sellars 

 Craig Sellars is a freelance 

Illustrator and Concept 

Designer living in Canada. After 

studying Industrial Design and 

Classical Animation, Craig worked as a traditional 

Layout Artist at Walt Disney and then transitioned 

to do digital work in the Games industry. As a 

freelance artist, Craig has worked internationally with 

numerous companies in the Games, Toy and Film 

industries. 

http://www.greensocksart.com/

sellarsart@hotmail.com

http://www.2dartistmag.com
http://www.ignaciobazanart.com/
mailto:i.bazanlazcano@gmail.com
http://www.gedomenas.com/
mailto:gediminaspr@gmail.com
mailto:simon@3dtotal.com
http://daarken.com/
mailto:daarkenart@daarken.com
mailto:simon@3dtotal.com
http://www.greensocksart.com/
mailto:sellarsart@hotmail.com
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Blackvolta
Black Volta was created 

after the team worked 

on a TGC franchise called “Myth & Legends”. They 

quickly realized that working together and sharing 

their experiences was a better way to improve their 

skills.  So they created a company and Black Volta 

was born. 

 

 

 

http://www.blackvolta.com/

bkvolta@gmail.com

Ioan 
 Dumitrescu 

Ioan Dumitrescu is a 20 year 

old architecture student and a 

self-taught concept designer. 

He loves drawing the things 

he imagines in his head and trying to convey a story 

to the viewer through them. He is currently working 

freelance. 

 

 

http://jonone.cgsociety.org/gallery/661127/

jononespo@yahoo.com

Contributors

http://www.2dartistmag.com
mailto:bkvolta@gmail.com
http://jonone.cgsociety.org/gallery/661127/
mailto:jononespo@yahoo.com
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All Tutorials Are Now Available 
As DVDs, Digital Downloads,

And Part of The Online Training Subscription

www.thegnomonworkshop.com

In this two volume series, Scott Patton shows the processes he uses to 
create a 3D character for feature films. The first volume explores 
Patton's fast and efficient method for concept sculpting, skipping the 
2D sketch phase all together and designing the character entirely 
within ZBrush®. He covers everything from blocking out the forms 
and fleshing out the muscles, to adding props, detailing with alphas 
and posing the character. The second volume covers methods for 
crcreating a final color rendering using ZBrush and Photoshop®. Patton 
shows how he squeezes the most from ZBrush’s powerful renderer to 
create both a wide and close-up shot of the character. He then shares 
creative Photoshop tips and tricks to quickly get to a finished piece of 
concept art from the ZBrush renders, covering topics such as adding 
and refining skin texture, hair, eyes, shadows and scars. Patton also 
discusses how to create backgrounds that enhance the character and 
ovoverall composition.

3D CHARACTER DESIGN SERIES
WITH SCOTT PATTON

LEVEL UP YOUR DIGITAL SCULPTING SKILLS

TRAIN WITH KILLER ARTISTS

http://www.thegnomonworkshop.com/subscription


“When it is time to draw 
or paint I put on music 
to help my creativity; the 
music choice is dictated 
by what idea or subject I 
have to illustrate”

Many of you will be familiar with this month’s interviewed artist as he has featured in our magazines on many occasions, and been a great source of 

advice for us with his amazing tutorials. Ignacio Bazan Lazcano tells us a bit about his first job in the CG industry and how he likes to balance his time 

between digital painting, traditional painting and having fun!
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Ignacio Bazan Lazcano Interview

Interview with Ignacio Bazan 
Lazcano 

Hi Nacho, I feel like we have known each other 

for a while now as we have worked together so 

many times, but for those who don’t know you 

can you tell us a little about yourself and how 

you got into the CG industry?

My name is Ignacio Bazán Lazcano and I live 

in Argentina. I have been working as a concept 

artist in the video game industry for five years.  

My first contact with the world of digital art was 

just by chance. Thirteen years ago, a friend of 

mine told me that someone was looking for a 

sketcher for a PC game. It was a “no money-

at-all” project, but we had dreams and wanted 

to make them reality. The PC game was finally 

finished and we could eventually sell some 

copies. I felt very proud to have been able to 

do the drawings (scenery, backgrounds and so 

forth), using crayons! At that point I was neither 

a professional sketcher nor did I have any idea 

about computers and digital art.  

After having obtained a university degree in 

Publicity in 2005, I soon realized that being a 

publicist didn’t suit me at all. I didn’t know what 

to do or where to go. I had been drawing since 

childhood, but it was still just a hobby. 

http://www.2dartistmag.com
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I was lucky enough to get the opportunity to 

turn my hobby into a career when I was hired 

by a small company dedicated to video game 

development. At that time I had not had the 

chance to buy my own personal computer, so I 

didn’t have any idea about using a computer to 

create art and did everything in the traditional 

way instead. Step by step I became accustomed 

to the way the industry worked. 

Nowadays I work as a Freelance illustrator, 

and develop concept art for AAA video games. 

I have experience in advertising media, 

animation, pixelart, etc. I’ve worked for several 

companies, such as Gameloft, Global Fun, 

Sarabasa, and lately for Timegate. As for the 

future, I really want to be able to learn from the 

best artists of the world. 

What are the opportunities like for a digital 

painter in Argentina? Do you find that you do a 

lot of work for foreign clients? Do you ever think 

of moving nearer to the huge projects?

In Argentina, lamentably, there are neither many 

opportunities for concept artists, nor any chance 

for other kinds of artists to work. My country has 

a high level of education and a very rich cultural 

history, nevertheless, many Argentine artists 

who have excelled because of their artistic talent 

have had to work abroad to win professional 

recognition. I think that in my country we haven’t 

yet learnt the worth of this kind of talent; if an 

artist hasn’t been recognized abroad first then 

he won’t be recognized. 

Argentina is a contradictory country. While 

everybody can study art, once you have been 

trained there are no working opportunities 

available to earn enough money to live well 

and meet your basic needs. Sometimes artists 

accept underpaid work to earn their living. 

My income comes mostly from foreign clients. 

They appreciate my work and give me an 

opportunity to reach a professional level. My 

dream is to work for a foreign company and to 

be taught by the best artists in the world, then to 

http://www.2dartistmag.com
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Better work will come with effort; it’s like going 

upstairs, step by step, climbing up from one job 

to another. Luckily the entertainment’s industry 

bring all this experience back to my country and 

work very hard to teach other artists also, and 

let Argentina be placed at the top, among the 

best countries to work in.

It seems like your route into the industry was 

a peculiar one. What advice would you give 

someone who had the ambition to be a concept 

artist?

I would say that the best thing to do is to work 

on any project you like, regardless of the 

payment you get for it. The most important thing 

is to have a good portfolio. Nobody will hire you 

if you only have one drawing to display. The 

point is to work on anything you can (comics, 

cartoons, etc). Exhibit your drawings in blogs, 

Facebook, Photolog, Deviantart anything. The 

world has to see what you are doing. Someone, 

sometime, is going to find you. 

is large and constantly growing, and as a 

consequence needs qualified people. One can 

be a concept artist for advertising, movies, video 

games, etc. There’s a lot of work to do.

I understand that you are a fan of music and you 

list drums as one of your interests, do you play? 

Also do you find that choosing the right music to 

listen to whilst painting influences your art and 

your mood?

I have always loved music and yes, I play 

drums. I like the drums a lot! I have been a 

drummer for twelve years, performing with 

several local rock bands. Nowadays, it is only 

a hobby, because I realized that I love drawing 

and painting more.

When it is time to draw or paint I put on music to 

help my creativity; the music choice is dictated 

by what idea or subject I have to illustrate. 

Generally I prefer British music; I love English 

rock bands, especially Queen, Supergrass, Blur, 

Morrisey, Artic Monkeys etc.

I am always amazed at the speed at which you 

manage to create breathtaking artwork. How 

long, on average, does a painting take you? 

And do you find you spend your whole time 

painting??

It is true that I work at high speed. This is 

because I know many exercises that help 

http://www.2dartistmag.com


ideas come quickly. Generally I find backgrounds and 

scenes fairly easy, and I also like science fiction characters 

very much. They are solid pictures that with simple bold 

volumes and a pair of geometric lines become modern or 

technological. The most difficult thing for me is gestures 

or facial expression and action or battle episodes, 

where human figures are generally in 

foreshortening or perspective.

Speed is the output of hard practice. 

I draw eleven hours a day: in the 

morning I attend art classes at the 

university, where I do my best to improve 

my expressivity. From Mondays to Friday 

I dedicate eight hours a day to freelance 

works. Of course that work is not the 

only thing I do! Thus, during weekends 

I take walks with my girlfriend or go to 

the cinema with her, meet friends, or 

sometimes I travel to nearby places, and 

so forth. 

I notice that you also paint traditionally 

- how much time do you get to spend on 

these kind of projects? And a really hard 

question: which do you prefer, digital or 

traditional?

I try to make a picture per month, 

but sometimes it is difficult to find a 

gap of spare time in my daily work 

to do it. What’s good with digital art 

is that it is fast and cheap. Not long ago time 

seemed to go more slowly, people were not 

in a hurry. Art work was sent by post office in 

parcels. On the contrary, today, everything 
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has to be done now! Clients want thousands of 

options, and all of them have to be made in 3D. 

As I always say, digital art is another means to 

hasten artistic production. I usually recommend 

understanding traditional painting first and only 

then, move on to digital.

If I could choose, I’d choose traditional painting. 

The great difference between traditional painting 

and digital art is that in traditional you can see 

the artist’s brush strokes, textures, volumes 

and energy, whereas with digital it is similar 

to printed pictures, with smooth surfaces. 

Nevertheless, I like digital art because it is 

speedy and lets you get high quality results.  

When I write my tutorials (which I like doing the 

most) I try to convey to readers the idea that the 

same picture could be done using a traditional 

technique. For this reason I usually don’t speak 

much about the program I have used. On the 

other hand I always try to ensure that everybody 

realizes how I’ve created the image. This way 

people are not tied down to a unique tool, and 

can learn that things can be made in more 

than one way. You may have noticed that I 

like teaching very much, as well as learning of 

course, because the learning path never ends. I 

thank God that I am ignorant about many things, 

and this gives me a personal goal to keep 

on enjoying myself in this wonderful world of 

drawing and painting.

  

You mention that you are a fan of teaching as 

well as learning. What do you think are the most 

important aspects of painting to understand as 

an artist?

Your question is very difficult for me to answer. 

I think that to be a good artist you must always 

look at everything and analyze the colors, 

shapes, objects, anything that captures your 

attention, and enjoy yourself a lot while doing 

it! One cannot go through life as if you were a 

horse with blinders pulling a cart, always looking 

to the road and not having any idea about 

what’s happening either side of it. If we are keen 

observers of everything we’ll be able to develop 

a high level of sensitivity that will make the 

difference when it’s time to draw or paint. Life is 

not long enough to learn everything you need. I 

think that the learning process never ends.

http://www.2dartistmag.com
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How do the subjects of your paintings differ from 

traditional to digital? Do you ever find that you 

are painting a traditional subject in Photoshop or 

a sci-fi battle on a canvas?

It is obvious that what I like most is to paint 

action scenes that take place with science 

fiction or medieval characters. When looking at 

my work, I realize that in nearly all my drawings 

there are several characters. I‘ve always liked 

to draw details and stories in the same scene. 

But when I paint on a canvas, I don’t know 

why but I’d rather paint “quiet” things, such us 

a landscape or a portrait. Perhaps the answer 

would be that because I have nearly no time to 

paint traditionally, whenever I can do it, I need to 

make something different from my daily work. 

If you could work on any kind of project what 

would it be?

I would really enjoy working on the pre-

production of a science fiction or fantasy movie, 

http://www.2dartistmag.com
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such as Avatar, Ironman, Star Wars, Lord of the 

Rings, etc. That would need new worlds and 

characters to be created. I feel that it must be 

unbelievable to see the result of one’s creations 

on the wide screen.

I know that I have a long and very difficult road 

to walk. But I also know that with patience and 

effort someday I shall be among the greatest 

artists, I already see me there. 

What’s your ultimate ambition for the future?

My ultimate ambition is to work on something 

great! And to learn from people that have 

been working in this industry for many years, 

either on video games or Hollywood movies. 

Obviously, this is an elusive goal. I have to 

keep trying again and again until I’ll get it. One 

has to compete against thousands of artists, all 

over the world, with great skills and that have 

perhaps got their university degree in places 

where companies visit universities to invite 

students to work for them. I know that if I get the 

opportunity I’ll be able to do great things.

Well thanks for letting us interview you. I am 

sure that a lot of our readers would have liked to 

learn a bit about the guy that keeps writing those 

excellent tutorials. When you make it to the top 

and work on those huge movies don’t forget us 

at 3DTotal!

Thank so much for giving me this opportunity 

to express and show my art in this beautiful 

magazine. I know that showing my art in this 

space will give me the opportunity to work and 

complete my dreams, and when I take this 

chance I will remember this magazine. It was a 

great interview. I enjoyed to talk with you. I see 

you in the next tutorial!

Ignacio Bazan Lazcano
For more work by this artist please visit:

http://www.ignaciobazanart.com/ 

Or contact them at:

i.bazanlazcano@gmail.com

Interviewed by: Simon Morse

http://www.2dartistmag.com
http://www.ignaciobazanart.com/
mailto:i.bazanlazcano@gmail.com
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“Whatever we take from 
the environment should be 
replaced or something new 
added in a positive way to 
balance everything out.”

Share One planet is a global art competition organized to promote the necessity to take more care of the earth and its inhabitants. In this interview the 

organizers catch up with poster designer Adrian Smith who talks about the necessity to care for the earth and the process in creating his work.
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Interview with Adrian Smith 
 
With in all those endangered species which 

“Share One Planet” competition focuses on, why 

you picked Yangtze Alligator for your poster? 

And how the image takes shape in your mind?

The great reptiles of our rivers, jungles and 

forests have always appealed to me. The larger 

reptiles such as the ‘yangtse alligator’ are very 

much kings of there species. Beautifully elegant 

as they cruise through the water and terrifyingly 

vicious when tackling its prey and then caring 

and tender when bringing up its young.

What are you trying to tell viewers through this 

poster?

Firstly I’m trying to convey the beauty of these 

animals while hinting at the life and lifestyle of 

these great lizards. Hopefully I’ve managed to 

put across a quiet moment in the day of a parent 

alligator.

In the poster we find unusual perspective. The 

adult alligator, the dragon head and the baby 

alligators locate in three distinctive levels. Why 

you apply such design?

My original plan was to have it so the first 

thing that attracted the viewer’s eye would 

be the young alligators in the foreground. 

http://www.2dartistmag.com
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This would show the hope that is still there 

for these endangered animals. Then the eye 

would hopefully carry up to the half seen parent 

alligator showing the animal in its prime. Lastly 

I wanted the old statue/carving to both show, 

firstly the passing of time and also to show 

that throughout the centuries these animals 

have been respected by the common man. 

The rising water level is to show how we must 

be more careful in how we treat our shared 

environments.

When dealing with traditional fine art, details 

comes from observing actual subjects in nature. 

When it comes to fantasy arts, sometimes 

the artist is building something doesn’t exist. 

How do you achieve believable detail in this 

instance?

I suppose my approach to fantasy art is to take 

something in reality and twist and stretch the 

idea in my mind and then put that onto paper. 

Then we have an object or scene or character 

that is strange and unearthly on first site but 

then we see similarities or hints of things in our 

real world. This helps sell the fantastical idea to 

the viewer. I suppose I have done the opposite 

with the ‘yangtse alligator’ illustration as I have 

shown a placid scene with the alligator and 

young but then added the fantastical looking 

Chinese dragon statue/carving.

Is this poster your first creation with 

environmental protection theme? What’s your 

idea of “eco-friendly”? For you what’s the ideal 

living environment for human?

Ideally I think it would be best if we could live 

in harmony as much as possible. We should 

use our great minds around the world to do 

more with cleaner energy and take more care 

in where we build our homes and factories. 

Whatever we take from the environment should 

be replaced or something new added in a 

positive way to balance everything out.

Share One Planet Competition 
For more information about the Share One 

Planet competition please visit:

http://www.shareoneplanet.org/en/index.aspx 

http://www.2dartistmag.com
http://www.shareoneplanet.org/en/index.aspx


page 21www.2dartistmag.com Issue 059 November 2010

Adrian Smith Interview

http://www.2dartistmag.com
http://www.shareoneplanet.org/en/index.aspx


http://www.digitaltutors.com/3dtotalprize


http://www.ssontech.com/


This month’s sketchbook brings us something a little different, as it is not just the work of one 
artist but of a whole art studio! Black Volta work as a close team to create great concepts; one 
artist does the sketching, another will play with it and refine it, a third will add color... I think you 

will agree that it will be really interesting to look into their processes!

“Perspective accuracy 
in 3D or any other 
theoretical tool is just 
a shortcut to create the 
necessary illusions to sell 
any 2D fantasy art”
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SKETCHBOOK OF Blackvolta
We love to sketch and have always found it a valuable tool for speeding up the creative process. A lot of the work we do at the Blackvolta Studio is 

done by a few members of the team. We love to see what we end up with.

In all the drawings there is an important technique or tool used to enhance the believability of the concept. For example in the image called 

“Strange Beauty” we apply a perspective system that allows us to calculate exactly where the viewer’s eye is looking (Fig.01 – 1x) and calculate 

perspective points in a graphical way. But the main aim of this process was to portray a sense of greatness in the main character in opposition to 

the guys in the background. It also makes it seem as if the viewer is in the scene.

http://www.2dartistmag.com
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In the image called “No Way Out” the colorist started with 

the concept (Fig.02 – 02e). That simple sketch set out 

the idea for the final drawing, and from there it was just a 

process of discussions and adaptations. In this particular 

case we went over the lines in the beginning, but later 

asked ourselves, what if we model the structure of the 

character in 3D and just use it as an accurate reference? 

That process went a little bad because we modeled and 

rigged a 3D skeleton and tried to trace it, but the figures 

looked so rigid and strange that we quit that path. So 

we went back to basics and did the sketch without any 

perspective reference or 3D, just plain gestural drawing and 

we think it works better. In the final drawing the composition 

is a central ellipse, and that creates the perpetual sense 

of movement guiding the eye around this central form and 

allowing us to narrate all the actions on the scene.

http://www.2dartistmag.com


Having learnt about this 3D technique, we cut the uses to a minimum. 

Trying to create a balance between 3D and 2D has been interesting 

and useful though, and has crept into our workflow. In the image 

“Below the Bridge” we created a 3D box wireframe render and started 

sketching on it, then with the final sketch we create a 3D scene and 

drew the characters on it (Fig.03 – 03f). 
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We are trying to absorb this 3D technique into our process but with 

more sensitivity than accuracy, because in the end the feeling of the 

work is what connects it with the audience. Perspective accuracy in 

3D or any other theoretical tool is just a shortcut to create the necessary 

illusions to sell any 2D fantasy art (Fig.04 – 26).

http://www.2dartistmag.com
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However we’re always exploring other 

ways to get a better result. Such as analog 

media, whether ink, oil pastels, oils etc.

Blackvolta
For more information please visit:

http://www.blackvolta.com/ 

Or contact them at:

bkvolta@gmail.com

http://www.2dartistmag.com
http://www.blackvolta.com/
mailto:bkvolta@gmail.com
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This month we feature:

Kashubo Ivan

Serge Birault

Othniel King

Gediminas Pranckevicius

Tiago da Silva

Rafael Nascimento

Steve Sampson

Branko Bistrovic

Yap Jia Xing

Keun-ju Kim
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Climate Changes 3
Tiago da Silva

http://grafik.deviantart.com/

tmds77@gmail.com

(Above)

Docking on P66
Othniel King

http://www.othnielking.com 

king.othniel@gmail.com

(Below)

http://www.2dartistmag.com
mailto:simon@3dtotal.com
http://grafik.deviantart.com/
mailto:tmds77@gmail.com
http://www.othnielking.com
mailto:king.othniel@gmail.com
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Pre-Loader City 2
Kashubo Ivan

ivankash.art@gmail.com

http://www.2dartistmag.com
mailto:simon@3dtotal.com
mailto:ivankash.art@gmail.com


page 49www.2dartistmag.com Issue 059 November 2010

The Gallery 10 of the Best send us your images! | simon@3dtotal.com

http://www.2dartistmag.com
mailto:simon@3dtotal.com


page 50www.2dartistmag.com Issue 059 November 2010

10 of the Best  The Gallerysend us your images! | simon@3dtotal.com

Mermaids Anguish 
Branko Bistrovic 

http://www.brushdreams.com/brankosfurnace.swf 

bisvic@gmail.com

(Below)

My Little Friend
Gediminas Pranckevicius

http://www.gedomenas.com/ 

gediminaspr@gmail.com

(Left)

http://www.2dartistmag.com
mailto:simon@3dtotal.com
http://www.brushdreams.com/brankosfurnace.swf
mailto:bisvic@gmail.com
http://www.gedomenas.com/
mailto:gediminaspr@gmail.com


Battle Princess
Keun-ju Kim

http://rabbiteyes.net/index.html

skipio-hanibal@hanmail.net

http://rabbiteyes.net/index.html
mailto:skipio-hanibal@hanmail.net
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Abducted
Rafael Nascimento

http://rafaelnascimentoart.blogspot.com

rafaelp.nascimento@hotmail.com

(Below)

Fluffy pup
Yap Jia Xing 

angusyap@hotmail.com

(Left)

http://www.2dartistmag.com
mailto:simon@3dtotal.com
http://rafaelnascimentoart.blogspot.com
mailto:rafaelp.nascimento@hotmail.com
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Stone Fish
Steve Sampson

http://www.thedarkinker.com/ 

contact@thedarkinker.com 

http://www.2dartistmag.com
mailto:simon@3dtotal.com
http://www.thedarkinker.com/
mailto:contact@thedarkinker.com


Alien Tako Sashimi 
Serge Birault 

http://www.sergebirault.fr/sb/index.php 

serge.birault@hotmail.fr

http://www.sergebirault.fr/sb/index.php
mailto:serge.birault@hotmail.fr
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Concept art for computer games is a fascinating field and an industry that a lot of aspiring digital artists would love to be involved with. This 

tutorial series has been written by some of the biggest and best names in the gaming industry, who will guide us through the way they would 

tackle the three main areas where concept work is required: environments, characters and accessories. The artists involved in this series have 

created a games brief themselves and are free to create their own vision of the description. They will reflect on the steps they choose to take 

from the point of receiving the brief up until they have created a completed concept for their required section.

Chapter 5: Accessories | Craig Sellars 



Game type: First person shooter  

Genre: Sci-Fi Year: 2300

The setting is Earth and the prison planet, Asturia. 90% of the game is 

on Asturia.
 

Plot summary: Lex Crane, a former police officer, is now the chief of 

security at Skye Global, the largest manufacturer of pharmaceuticals 

on the planet. Lex discovers something about the company he works 

for that he shouldn’t have, and this starts a chain reaction that causes 

him to be wrongly accused for the murder of his family and a local 

politician.  He is sentenced to life imprisonment on the prison planet of 

Asturia. On the prison planet he is constantly targeted by the criminals 

that he put there all those years ago, along with an unknown enemy 

within the prison walls hired by Skye Global. Lex was framed by Skye 

Global’s CEO, Lance Shepherd, and Shepherd is now trying to have him 

killed in a place where nobody will miss him or even realize he’s dead. 

Lex is trying to escape from the prison and return to Earth, where he’s 

convinced he can find the evidence to clear his name. Along the way he 

forms unexpected alliances and is disappointed by shocking betrayals.

The environment: The setting is dark and cold. The planet is basically a 

giant rock. There is no lush foliage or vast bodies of water. Instead there 

are pits of oil and sludge. The terrain has large, jagged rock formations 

jutting out sporadically throughout the landscape. The sky is constantly 

filled with flashes of green lightning, which brings on poisonous rain storms.

There is a giant prison facility that has been placed on the planet to house 

the galaxy’s most violent and evil criminal element. Escape is rarely ever 

attempted because of the sheer fact that outside the walls survival is not 

possible. The extremely harsh climate, along with the predatory dangers 

that exist on the planet, make it so that the prisoners would rather stay 

confined to prison. At least there is food, shelter, warmth etc., inside the 

jail.

Prisoners are forced to work as part of their sentence.  The labor camps 

are set up throughout the perimeter surrounding the prison. They are 

forced to mine for the oil that exists deep within the surface of the planet. 

Along with these intensely laborious tasks of digging and mining, the 

prisoners are also constantly expanding the facility to house yet more 

prisoners.  



page 58www.2dartistmag.com Issue 059 November 2010

Chapter 5: Accessories Concept Art for Games
Concept Art for Games: 
Part 5 - Accessories
Software used: Photoshop

For my first chapter in this project I want to 

design a drop ship or prisoner transport for the 

prison planet Asturia.

When I set out to design anything for a game 

the first thing I consider is how whatever I am 

required to design can help tell the story and 

add to the  mood.

 

In this case I’m setting out to design a transport 

vehicle solely used to ferry highly dangerous 

prisoners to and from the remote planet’s 

surface. I want the vehicle to feel heavy and 

a bit clunky - sort of utilitarian where form 

follows function (that is to say that the ship’s 

construction is dictated purely by the mechanical 

requirements, with no thought to making it 

aesthetically pleasing). I decide it’s important 

to emphasize how inhospitable the planet’s 

environment is so I want the vehicle to look run 

down, as if flying in Asturia’s atmosphere has 

taken its toll on the ship.

When sketching out initial ideas for something 

like this, I would usually use a blue pencil then 

markers and a tech pen for cleaning it up, but 

I have increasingly started to use Photoshop 

for the sketch process as well as the finished 

pieces since it is so efficient and versatile. 

 

I’m trying to design something that is heavy yet 

feels fast with a lot of control surfaces (Fig.01). 

There is a lot of potential for moving parts, 

constantly adjusting as the ship flies through 

the turbulent atmosphere. While I like the idea 

of this design I feel it’s a little too bird-like or 

elegant to be a heavy old prison transport.

 

With this rough sketch I go for a more traditional 

rectangular box shape, in the spirit of classic 

shuttles like in Star Trek (Fig.02). However to 

make this shuttle look more utilitarian, I add 

large, oversized engines to the sides, expose 

mechanical details along the underside and add 

some less prominent control surfaces for added 

movement. Whilst I like the heavy feel of this 

design, I think it lacks an distinct silhouette.
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For my third sketch, I try to create a fuselage 

shape that’s more like a tugboat or transport 

boat with a prominent control room/cockpit 

up front for maximum visibility in turbulent 

atmospheres (Fig.03). At this point I realize 

that this boat theme provides an opportunity to 

incorporate more “story” into my design, and I 

place the compartment that the prisoners ride 

in at the bottom of the vessel. The idea is that 

since they are so dangerous, the prisoners are 

kept in the bowels of the ship and as far away 

from the crew as possible. Also, the fact that 

they are kind of hanging on the bottom of the 

ship like cargo, reflects how little concern the 

crew has for the prisoner’s lives. 

While looking through references of heavy 

military machinery and I come across an image 

of what I think is a portable bridge. I really like 

the aggressive and unconventional shape so I 

incorporate this into the design, thinking these 

large forward projecting shapes could be control 

surfaces that regulate the descent of the ship 

as it both flies and falls through the turbulent 

atmosphere (implausible from an engineering 

standpoint, but sometimes it’s about creating 

interest above all else). I finish this idea off with 

a heavy array of engines retrofitted to the sides.

 

At this point it’s time to review my three 

sketches. Fig.03 is the direction I decide to take 

as it fills all of my design goals.

 

To start out, I sketch my design on a blank 

canvas (Fig.04). At this point I am carefully 

choosing an angle that gives the most dynamic 

view of the vehicle. Sometimes, I’ll do this step 

by creating a simple 3D block model so I can 

rotate around to get the best angle.

Next, I place a background wash of color behind 

the sketch (Fig.05). This is to represent the sky 
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and color of the planet’s atmosphere, but more 

importantly it is the key color for my painting 

and the base into which I will paint. I create this 

“wash” by layering in a couple of non-descript 

sections of a sky photo, then adding solid color 

overlays on top and adjusting the transparency 

so I have some color variety and texture.

 

Next I start layering in textural images as 

overlay layers (Fig.06). These are made up 

of photos of metal and rusty surfaces etc and 

provide me not so much with detail, but with 

local color that I can use to start painting and 

defining the vehicle. At this point I alter the color 

and value of the sky to make the vehicle stand 

out more against the background. 

 

Even during the final illustration stage I am 

always altering things as I work out what looks 

best and here I adjust the overall color again 

(Fig.07). At this point I am mainly drawing into 

the image and establishing the lighting on the 

vessel, all to help define the surface planes. 

I am also starting to think about detail a little 

and, when looking in my reference folder, I 

find a photo of a big iron collar fitting on an old 

industrial pipe. I paste that into my image for the 

front opening on the cylindrical engine body. I 

often do this early on not just to provide detail 

for a specific area, but I find it encourages me to 

push forward in defining other things as quickly 

as possible

I continue to draw into the ship, conscious of 

preserving areas of blank or empty surface to 

compliment the areas with large amounts of 

detail and “busy-ness” (Fig.08). I always try 

to make sure I am keeping in mind the purpose of my design within the 

story. So at this point I add and define a metal framework surrounding the 

prisoner compartment at the bottom of the vessel. This is a retractable 

cage which surrounds the prisoner compartment and visually emphasizes 

the dangerous nature of the characters locked inside.

 

At this point I am adjusting the values as I go, refining the shadows so 

they aren’t too dark and tweaking the color of the light (Fig.09). I also 

focus on the engine area. The two distinctly different engine housings 
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sandwiched on top of each other feel a little too 

clumsy, so I paint out the top housing and imply 

the mechanics of the upper wing base which is 

now visible.

 

I also feel at this point that the nose of the 

fuselage is a little too organic for my clunky 

spaceship design so I shave it down a little to 

be more boxy, then add a glass canopy for 

the cockpit that is more evocative of an old 

transport train and more in keeping with my 

theme (Fig.10). It seems that the wings feel a 

little too flimsy even for my fictional design, so I 

incorporate some heavy struts that anchor them 

to the main fuselage and support the overhead 

wings. 

At this stage I am nearing the end, and I work 

over the whole vehicle adding some details and 

removing others. I continue to tweak the overall 

color and add background flecks and streaks to 

better imply a sense of motion in the final image.

 

This finished illustration would then be 

presented to the Art Director and other 

stakeholders on the projects. If approved, front, 

side, top and bottom elevation drawings would 

be generated for modelers to work from. This 

type of color illustration is often pivotal in getting 

an idea approved, as it portrays the concept 
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in a dynamic yet descriptive way that allows 

everyone to get the feel of the potential final 

design (Fig.11).

Craig Sellars
For more from this artist visit:

http://www.greensocksart.com/ 

Or contact them at:

sellarsart@hotmail.com
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Chapter 01 | Male | Mike Lim (Daarken)

“When you have a live 
subject you can see exactly 
how the light interacts with 

the planes of their face”

Portraits are one of the most commonly tackled subjects in all forms of art, but also one of the most common that we see 
go horribly wrong. In this series our talented artists will be showing us how to use a photo reference to paint an accurate 
portrait without being tempted to do a paintover. We don’t stop there though; we also venture into the specialized field 

of caricatures. Caricatures are a tricky subject to deal with, but there are ways that you can use your photo reference to 
make them easier and this series gives us an insight into this process.
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Portraiture -  Chapter 01: 
Male 
Software used: Photoshop

Gathering Reference
The first thing I do when painting a portrait is 

to gather my reference. Even for concept work 

I try and find some type of reference, be it 

costume ideas, texture swatches, inspiration for 

the color palette, just anything that will get my 

mind rolling. Getting the right type of reference 

is extremely important if your goal is to paint 

someone’s likeness. You may think you know 

what someone looks like, but do you know every 

nuance well enough to paint them from your 

memory? Most likely not. I suggest painting from 

life when at all possible. Painting from a photo 

can flatten out the forms and cause distortion 

from the lens. When you have a live subject 

you can see exactly how the light interacts with 

the planes of their face. That being said, I am 

going to paint my portrait from a photo! Make 

sure that your subject has some interesting 

shadow shapes on their face, so if you are using 

a camera be sure to turn the flash off. The last 

thing you want is a subject that is all blown out.

Finding willing subjects to sit for you or allow 

you to take their photo can be tricky sometimes, 

but you always have yourself available as a 

model. May I also suggest that you leave self-

portraits out of your portfolio and only use them 

for practice. The last thing a client wants to see 

when looking through your portfolio is your face 

staring back at them!

The Line Drawing 

In a previous tutorial I explained how to paint a 

male portrait from memory using large shapes 

and silhouettes, but in this tutorial I am going 

to start off using line. In school they taught us 

how to paint portraits in oil by first laying out all 

of the major landmarks in line. If I were doing 

this in oils I would first draw out the structure 

using burnt umber that was thinned out with 

turpentine. I only really need to worry about 

drawing in the details for the light side of the 

face and for the shadows I can just block in 

large shadow shapes. Since I am doing this 

digitally I can just open my reference in 

Photoshop and paint next to it. I would avoid 

color picking from the photo because you want 

to train your eye to see colors, plus color picking 

from photos can be deceiving because if you 

zoom in really close on a photo you can see 

that there are many other colors that you can’t 

see zoomed out. You may also want to change 

some of the colors, depending on what you are 

going for in terms of mood and style. 

The trick to painting a likeness is all in the 

structure of the face. The little details aren’t 

as important as the overall head shape and 

structure. If you can get someone’s brow right, 

or their eye socket shape right, you are well 

on your way to painting a good likeness. If you 

squint your eyes you can focus more on the 

large shapes instead of the details. 

When I look at my photo, I am looking for the 

large shadow areas and the shape they create 
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(Fig.01). Typically when I start drawing a 3/4 

view I will start with the brow of the far eye and 

work my way up the forehead. I can then come 

down and block in the large shadow shape 

for the eye socket and the large shadow area 

under the cheek on the left side of the face (the 

viewer’s right side). There is a large area of 

shadow under the nose, so I can knock that out 

in a few large strokes as well. 

Right now I am using a rectangular Chalk brush 

at 100% Opacity. The way I change my Opacity 

is by how hard I press on the tablet. To do this 

go to Window > Brushes and make sure to click 

the box next to Other Dynamics. Under other 

dynamics make sure you have Opacity Jitter set 

to Pen Pressure. I like using the Chalk brush 

because it has a little bit of texture and it acts 

more like an actual paint brush, allowing you to 

knock in the various planes. When I say “planes” 

I mean direction changes in the form. 

Once I have the large shadow shapes in place 

I can go in and start blocking in the details, like 

the shape of the nostril and the shape of the 

eye (Fig.02). If you noticed, I am just blocking in 

the large overall shape and not all of the details 

inside the shape. Like the eyes, I don’t have the 

eyeball detailed out or the iris, only the general 

outside shape. Try to be as accurate as possible 

when painting these shapes. Really look at the 

model and try to understand what the forms are 

doing. 

There are also some general rules that you 

should be aware of when painting a face. 

Generally there is one eye width between the 

eyes; the corner of the eye starts at the edge of 

the wing of the nostril; the corners of the mouth 

line up to the middle of the eye, and so on. 

These are good rules, but they are not always 

true. I know from painting previous self-portraits 
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that my eyes are actually 1.5 eye widths 

apart. Also, be sure to check the angles of the 

individual features (Fig.03). Hold your pencil 

up and measure the angle of the eyes, or the 

angle of the mouth. Don’t worry too much if your 

painting doesn’t look exactly like your subject, 

it will come together as you begin to add color 

and value. 

Tricks of the Trade
Working digitally has a lot of perks that you 

should be sure to take advantage of. The Undo 

button is your friend, although some might 

beg to differ. Some argue that having an Undo 

button so readily available causes artists to 

become lazy or it might cause them to lose their 

edge. Sure, not being able to undo causes a 

person to become more vigilant in their choices 

and their drawing/painting ability, but it all comes 

down to the end result. Is your illustration better 

because you were a purist and never erased 

anything, or is your illustration stronger because 

you recognized your errors and you corrected 

them? I am sure that subject will be debated 

until the end of time. 

There are also several tools that will allow you to 

fix your mistakes without having to repaint large 

areas. The Warp tool allows you to warp areas 

by pushing and pulling dots that are situated in 

a 3x3 grid, almost as if you were modifying a 

3D object (Fig.04). Some of my features aren’t 

wrapping around the form as much as I had 

hoped, so using the Warp tool to wrap them 

around the form a little more is a quick and easy 

solution. Don’t think that this is a perfect solution 

though; you can only warp something so much 

until it starts to look weird. 

Once you have things close to where you want 

them, you can go in and fix your mistakes 

manually. My ear is a little too high compared 

to the photo (Fig.05). Since I have my drawing 

on several different layers, I need to find a way 

to move them. Doing a Copy Merged will merge 

all of the visible layers in your selection and spit 

them out in one nice, happy layer. Just select 

the area you want to move with the Marquee 

tool and then hit Ctrl + Shift + C, for PCs, or 

Command + Shift + C, for Macs. You can also 

find it by going to Edit > Copy Merged. Now, 

with your selection still selected, hit Paste (Ctrl + 

V for PCs or Command + V for Macs). This will 

paste all of the merged layers into a new layer 

that you can modify. Using the Move tool I can 

move my ear down. If you just want to make 

minor changes use the arrow keys to move your 

selection. 

Behold! Color!
The single most asked question I receive is how 

do I add color to a black and white painting. First 

of all I would like to dispel the belief that adding 

color in Photoshop is achieved by a simple click 

of a button. Sure you can add color using a 

color layer or an overlay layer, but chances are 

it won’t look very good. Usually I start by adding 

color through the use of a color or overlay 
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layer, but then I build the color up using several 

different layer modes, color balance, and levels 

(Fig.06 – 07). Once that is achieved you have 

a good starting point, but not an ending point. 

After you have the base colors established you 

will need to go in and paint opaquely on top 

of everything the old fashioned way (Fig.08). 

I throw down big specular highlights on the 

forehead just so that I can gauge my value 

range and make sure that my other lights aren’t 

brighter than that highlight. I’ll go in later and 

make it even brighter as well as push the darks 

so that my painting pops a little more.  

In the reference picture you can see a lot of 

bluish light on the left side of the photo. That 

light is coming from the computer monitor. After 

playing around with adding the blue light in the 

painting, I decide against it and go with a more 

traditional look. If you are using a reference 

don’t be a slave to the reference, know when to 

deviate or when to stick to the reference. 

Right now I am trying to stay pretty loose with 

my brush strokes. I won’t add little details until 

the very end. I also stay zoomed out so that I 

can see the entire painting. This allows me to 

see how each element relates to another and 

also helps me avoid getting bogged down in 

the details. Since the face already has a lot of 

yellows and oranges, I didn’t want to keep the 

background a brownish color (Fig.09). I really 

wanted the face to pop, so I decide to make 

the background more blue/green. You’ll notice 

that I’m using the background color to carve 

in on the face. As I paint I do a lot of push and 

pull with the paint, the same way I would if I 

was using oils. The shirt and neck aren’t as 

important, so I make the background get darker 

towards the bottom in order to pull the focus to 

the face. The face is a little on the green side, 

so I want to change that by using an adjustment 

layer (Fig.10–11). On your layer palette click on 

the half black half white circle near the bottom. 

This will bring up a number of choices, but we 

are going to select Color Balance. The great 

thing about adjustment layers is that they don’t 

actually change your painting, so if you don’t like 

the changes you can just delete them and your 

painting will be back to normal. 

Chip Away
The basic structure and color palette has been 

established, so all we need to do now is to refine 

the painting, one step at a time (Fig.12). Using 

the Liquify tool and the Warp tool I can pull the 
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eye sockets and nose out a little bit since they 

seem like they are pinched in a little too much. 

I also rotate the ear counter clockwise and the 

mouth clockwise. For the facial hair I use a 

Speckle brush instead of painting in each hair by 

hand. Don’t go too overboard with specialized 

brushes because they can end up looking “too 

digital” or they can make repeating patterns. 

Usually I will add facial hair on a separate layer 

so that I can go back in and erase out parts that 

repeat too much. 

Flipping your image often will help you 

recognize your errors more easily and give you 

a new perspective on your painting (Fig.13). 

Taking regular breaks can also give your eyes 

a rest so that when you come back you can see 

things that need to be fixed. I have mine bound 

to Command + F. To make your own shortcut 

you can go to Edit > Keyboard Shortcuts. Click 

the arrow next to image and then scroll down to 

Rotate Canvas > Flip Canvas Horizontal. You 

can then enter your own shortcut and hit Accept 

and then Ok. 

My image is also looking a little fuzzy, so I think 

I will sharpen it up a little. Make sure that you 

have your entire image on one layer. If you 

don’t, just select the entire canvas by hitting 

Ctrl + A (or Command + A) and then do a Copy 

Merged (Ctrl + Shift + C or Command + Shift + 

C) and Paste (Ctrl + V or Command + V). Now 

go to Filter > Sharpen > Unsharp Mask. You can 

play with the settings until you get something 

you like. Comparing my painting to the reference 

I can tell that the angle of the cheeks is wrong. 

The angle of the bottom of the nose is a little off 

too.

Most of the time I only use the default Round 

brush, so sometimes my paintings can look a 

little “digital” and clean. Whenever possible I try 

to use custom brushes to add in little hints of 
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texture here and there (Fig.14 – 15). You can also add texture 

overlays over the entire image. Grab a texture you like and add 

a new layer. Paste that texture into the new layer so that it fills 

the entire canvas. Next change the Layer Mode to Soft Light and 

drop the Opacity down to 30%. You don’t want to overdo the 

texture because it will defeat the purpose and make your painting 

look fake. My value range isn’t quite what I want, so I add a Color 

Dodge layer and paint into it using a dark gray. Using a neutral 

color will preserve the colors of your painting. Also, don’t pick a 

gray that is too light, otherwise you will blow out your painting. 

The Liquify tool is an awesome tool that will let you change 

your painting quickly without having to repaint anything. It is a 

great tool for concept artists that need to make changes quickly 

(Fig.16 – 17). Select the area you want to change and then go 

to Filter > Liquify. The far eye is too small, so instead of using 

the Transform tool I can use the Liquify tool to make a more 

seamless change. Once you hit Liquify there will be a number 

of new icons on the left side of the screen. The one we want is 

the fifth one down. It will allow you to increase the size of things. 

Once I have that selected I can change the brush size using the 

Brush Size option to the right. All I have to do is tap down on my 

tablet to increase the size of the eye. Once I have the changes I 

want I just click Ok. 
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Make it Fat
After coming back to the image I can see 

that the face and neck look way too skinny 

compared to the reference (Fig.18). In order to 

“fatten” up the face I flatten the image, select 

everything, and then hit Ctrl + T (Command + T) 

to transform it. I then pull the side handle bar out 

and boom, instant fatness added. For the neck 

I just paint it in the old fashioned way and add 

in a little bit of a bluish rim light on the back of 

the neck. Another important aspect of painting 

a portrait is knowing when to exaggerate or pull 

back certain features. If you were painting an 

upper class woman, you might want to make 

her look a little more elegant by lengthening her 

neck. Again, it just depends on what you are 

trying achieve with your painting. I guess that 

sometimes when working on a self-portrait you 

feel the need to cheat a little and take off a few 

pounds or edit out some wrinkles.  Don’t fall into 

the trap, make it fat! 

Poke a Stick in it
The hardest part is knowing when you are done. 

If you feel that you’ve accomplished everything 

that you set out to do and you are happy with 

the result, don’t stop, because you still have 5% 

more to go. Step away again and come back to 

it later. I can almost guarantee that you will find 

something you will want to fix or change when 

you come back to it. When I came back to mine 

I noticed that the mouth was too far forward and 

the colors were not where I wanted them to be. 

I added more blues, reds and purples since the 

skin tones were still a little too yellow/green. I 

only put two hours into this painting, but I felt 

that it was in a place that I felt comfortable with 

calling it finished (Fig.19 – 20). 

I hope you enjoyed this tutorial and learned a 

thing or two about painting portraits. Thanks!
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For more from this artist visit:

http://daarken.com/

Or contact them at:

daarkenart@daarken.com
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Fantasy plays a huge part in digital art. It influences thousands of 

artists from around the world and has become a large part of the film 

and gaming industry. So much of what we see within this genre is 

drawn from fairy tales and folklore. In this tutorial series our artists will 

be showing us how to research creatures from folklore and use this 

gathered information to create an original and accurate depiction of 

these fantasy characters.

Chapter 1: September Issue 57 | Goblin | Andrei Pervukhin 
Chapter 2: October Issue 58 | Fairy | Nykolai Aleksander 
Chapter 3: This Issue | Siren | Min Yum 
Chapter 4: Next Issue | Ogre | Richard Tilbury 
Chapter 5: January Issue 61 | Troll | Simon Dominic Brewer
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Painting Creatures From 
Folklore: Chapter 03 - Siren
Software used: Photoshop

Introduction
I sometimes start a picture without a strong idea 

in mind, especially with subjects I haven’t dealt 

with before, and it quickly leads to a research 

session for a small collection of reference 

images. Because of this my process usually 

begins with research. I think it’s important to 

prepare right at the start rather than late in the 

day as it can save so much time and trouble 

later on. Good research can also lead to ideas 

and inspiration as well as help you get all the 

facts right about your subject matter. It turns 

out that my initial ideas about sirens were 

slightly incorrect when I began my research. 

I’ve always pictured them more like monsters, 

ready for battle but they were usually described 

as a beautiful seductive bird-like women or like 

mermaids luring men to the sea.  

In this workshop I am going to share my process 

of creating a painting from sketch to the finished 

piece, as well as share some of the tips and 

methods I frequently use in Photoshop.

Sketch
I started by roughly sketching out some ideas 

as small thumbnails. When doing thumbnails 

I usually try to arrange the elements whilst 

focussing on composition. I also avoid focusing 

on details at this stage; I just roughly put down 

the ideas and see if they work visually (Fig.01). 

Refining sketch
I decided to go for the mermaid look for my 

Siren. I like to try something new with every 

piece of artwork I do, and since I’ve never drawn 

a mermaid creature this was an obvious choice 

for me. I cleaned up the sketch a little here with 

some minor anatomy details and took a mental 

note of how the background would be painted 

(Fig.02). 

Blocking in
Using some big textured brushes, I blocked in 

some background colors. There’s something 

about using strong contrasting colors that adds 

to a piece of art and this is no exception. I 

went for  orange and blue. I was feeling a bit 

adventurous and went with a very bold orange, 

hoping I could offset this with cool lighting on the 
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character against the warm orange background 

(Fig.03).

Defining the figure
I next established the lighting. I tried to keep it 

subtle by using a slight spotlight from top left. 

I also adjusted her skin tone to help her stand 

out from the background. At this stage I also 

roughed out the overall form of the figure and 

the rock (Fig.04).

Rendering
With all the elements in the right places, the 

rendering begins. This process is probably 

the most time consuming part. I usually start 

with the focal point, in this case the figure. My 

workspace in Photoshop usually consists of two 

document windows. One zoomed out at around 

25% and the other with a close up view so that I 

can work on the details and check how it works 

overall in the other window. Digital painting has 

the advantage of being able to zoom in, but 

also at the same time it can lead to overworking 

an area which may lead to inconsistency 

throughout the image. Opening up another 

window can be done by going to Windows > 

Arrange > New Window for xxxx.psd (Fig.05).

Adding details
I started adding the details and worked on the 

features like her face. I tend to avoid using 

textured brushes at this stage as they don’t give 

you finer controls. Blending with a low Opacity 

brush can often lead to muted colors as you are 

painting over semi transparent colors over and 

over again. It’s good to select the original color 

again once in a while to bring back the original 

colors. Another method I use is Overlay brush 

blending modes to put back some of those 

vibrant colors that were lost during the blending 

(Fig.06).  

Rendering Form
If you’ve tried rendering a simple sphere or 

cylinder, you may have heard of the term “core 

shadow”. This refers to the region where the 

shadow starts, shown here with a red arrow 

(Fig.07). This area is darkest because of the 

reflected/diffuse lighting in the shadow region. 

One thing I do tend to do is accentuate this area 

with more saturated colors, usually from the 

warm colors in the surrounding environment. 

This works really well with rounded forms but 

also with edge of the shadows. A soft edged 

brush with Overlay Blending mode does the job 

well (Fig.07).  
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Tidying up
After many hours working on the image the 

painting was almost done. I added more detail 

and a warm orange outline around the figure 

to help differentiate her from the background.  I 

looked out for any inconsistent brush strokes 

which can happen when working on a detailed 

image. I also got rid of unnecessary details 

especially in the background texture. Flipping 

the canvas horizontally is a simple and easy 

method to check for any obvious mistakes; I 

periodically flip the canvas when I’m working 

to see if anything looks odd. One of the things 

I focused on was the fact that I wanted to keep 

the background simple and not conflicting with 

the main focal point of the image (Fig.08).

Corrections
There were couple of things in the image that 

didn’t seem quite right. The head of the figure 

seemed a little too small and the tail felt a bit 

unnatural. A quick adjustment of the head fixed 

the proportion issue, but the tail needed a bit 

more work, particularly with the way it rested 

on the rock. Also it needed more highlights to 

suggest a shiny texture (Fig.09).  

Finishing up
After adding the final touches and a couple 

of colour adjustment layers, the painting is 

wrapped up. I am satisfied with the overall 

feel of the image and the fact that I haven’t 

completely lost all of the bold colours I begun 

with (Fig.10). 

Min Yum
For more from this artist visit:

http://www.minart.net/

Or contact them at:

minyum@gmail.com
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3DTotal presents the new issue of 3dcreative
magazine: a downloadable monthly magazine for 
concept art, digital & matte painting for only £2.75 (approx $3.78 - €2.93)

visit www.3dcreativemag.com 
to download the free ‘lite’ issue, the full issue, subscription 
offers and to purchase back issues.

http://www.3dcreativemag.com


Intro Text

Custom brushes are not only a great way to increase the speed at which a painting can be completed, but can also create an effect that would 

otherwise be impossible. They can be used in many different types of scene, but many would argue that they become most useful when 

creating a space scene. In space many items need replicating or reproducing in vast quantities, which can be difficult, but custom brushes can 

make this process much easier and simpler. In this series the artists involved will be showing you how to create brushes to improve your scene 

and how to use them to the best effect.

– Free Brushe Images

Chapter 01:  Asteroid Belt | July 2010

Chapter 02:  Egyptian Sci - Fi Scene | August 2010

Chapter 03:  Night-Time Sci-Fi City Battle | September 2010

Chapter 04:  Underground Corridor | October 2010

Chapter 05:  Underwater City | November 2010

Chapter 06:  Sci-Fi Ruins | December 2010

http://www.2dartistmag.com/tutorial_resources/issue_059_nov_2010/tutorial04_brushes.zip
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Custom Brushes For Sci-Fi 
Chapter 5 - Underwater City 
Software used: Photoshop

Hi guys, in this tutorial I will take you through 

the steps I took when making an underwater 

environment with the help of some custom 

brushes that I’ll explain how to create along the 

way.

When I did this image I woke up to early in the 

morning and I already had a pretty clear idea 

of how I wanted the final image to look. My first 

steps usually differ from image to image but 

as this was the first drawing of the day I did a 

quick loose line drawing to establish a rough 

composition (Fig.01).

I knew I wanted the underwater scene to have 

a remote control unit, a couple of divers and a 

main ship on the surface. They would be diving 

into a cool environment surrounded by all kind 

of weird rock formations.

So the next step was adding values. I chose to 

do it directly in color as there wouldn’t be much 

color in a piece such as this anyway. The blues 

and greens of the water would be all over almost 

the whole image. For the submersible I chose 

a simple white and yellow scheme. I still wasn’t 

sure about the rock formations but I knew I 

wanted some cool shapes that I could have fish 

swim around, and have all sorts of vegetation 

and corals hanging and growing from (Fig.02).

Once I had the basic color scheme and values 

settled I removed the line drawing and started to 

refine my shapes (Fig.03).

I really wanted to avoid overworking this image, 

as water scenes do tend to blur out and loose a 

lot of detail. The noise, sediments, and lack of 

light all affect how much you can see.

I added in a quick picture of a seaside shore I 

took this summer and start painting over it so I 

could have a foreground element that sets the 

submersible in place, and gives depth to the 

other rock structures. I picked up a textured 

brush and tried to emulate a dirty, full-of-spots 
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kinda look, and added a bit of contrast between 

the heavy shapes and thin ones. I then started 

to flesh out the sub (Fig.04). Because of the 

rocks I was planning and the organic shapes 

around them, I added some lights to the sub 

just so it can see ahead as it goes deeper, and 

in the middle a camera to record its journey 

(Fig.05).

I then refined the rocks in the mid-ground and 

foreground to keep the image heading in the 

right direction. I added a bit more of the same 

photo texture to the mid-ground rock formations 

and another hole in the left foreground structure, 

just to give it even more depth and contrast.

At this point the environment was pretty much 

so done so it was time to add some life and 

a bit more dynamic movement to the scene 

with the help from our good friend: the custom 

brush. I’m not a big fan of creating my own 

brushes although I do have a couple that I like 

to use regularly. For this piece first things first, 

I needed a fish brush that could emulate fish 

swimming around.

I opened a new file, and started drawing 

different kinds of fish. I took a short walk down 

memory lane and remembered all the discovery 

programs I had seen, and picked out a few 

formations that could work in this scene. 

First I drew some fish that weren’t going 

anywhere soon - they were just admiring the 

view (Fig.06). Next were fish swimming around 

in a hurry - huge packs of fish swimming like 

crazy around rocks and coral (Fig.07). Finally I 

knew I wanted a type of Mackerel-like fish and a 

thinner fish that would look good when I painted 

them in a big row in huge numbers (Fig.08). I 

tried to vary the size and shapes of the fish so 

that even if they were tiled there would still be a 

difference.

I then took each layer individually, went to Edit > 

Define New Brush Preset, opened up my brush 

menu and started playing with the settings. I 

knew I wanted to change the Scattering, Shape 

Dynamics and maybe Color Dynamics settings. 

I changed Shape Dynamics so rotation would 

follow the direction I painted. I also changed 

Size Jitter to a higher value, around 60. I wanted 

the fish to keep tight together in a mass, like 

they do in real life, so I lowered the Scatter 

amount and increased the count a little more to 

achieve this effect.

Custom brushes are all about fiddling and trial 

and error until they fit your needs. Especially in 

the ones that are trying to replicate something 

from real life! When you’re happy with a brush 

and its settings, you can go ahead and right 

click on the Brush menu and go to New Brush 

Preset. That creates a new brush from your 

modified one and also keeps the rough version 

in case you want to modify it later.
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Now it was time to populate (Fig.09). I knew I 

wanted the fish to go around the rock columns, 

and near rocks, like they were hiding from the 

sub. But I also wanted some to be surprised 

by it so I put them into the light as a secondary 

focal point. I just locked the transparent pixels 

in the layer menu (Ctrl + click works as well) 

and started painting over them to give them a 

bit of shine and texture, trying to treat them as a 

group. Now the image was coming alive!

I knew that beside these I wanted some 

underwater vegetation which would be a good 

ground for fish to play or hide in. So it was time 

to draw the kelps and seaweed that was going 

to be growing on to the rocks.

I followed the same process to create this kelp 

and seaweed custom brush. I opened a new file 

and started a few kelp leaves on a new layer. 

After some experiments I noticed that if I drew 

too many leaves the tiling was becoming more 

obvious, so I narrowed it down to only a few. I 

then made the brush and started playing with 

its dynamics, changing Size Jitter to 60, Angle 

Jitter to direction, adding a small amount of 

Scatter and a big count, and making a little color 

dynamic change to the Hue and Brightness 

Jitter. I actually created two versions of this 

brush so I could have a bit more variety in the 

environment (Fig.10 – 11).

Next I started adding a few columns of kelp 

rising to the surface. I tried not to put them in 

a straight line, so it looks more like they are 

floating and their roots are keeping them on the 

rock. I also erased some parts out and painted 

some new leaves in where it seemed to boring, 

but nothing big. The brushes did their job well.

I also punctured the right foreground just to get 

a glimpse at a coral in the background. I then 

focused a little on the divers, refining their edges 

and silhouettes and then added a cable that 

powers the sub from the mother ship.

The ship was looking a bit small so I enlarged it 

and made a trail behind its main propellers. The 

right foreground rock looked a little too clean so 

I added a few pieces of coral using my shaky 

hand (Fig.12).

So everything was pretty much in place at this 

point. Just one thing was missing: the bubbles 

from the divers, sub and random fish. I went 

into my brush files and painted some rough 

spots to mimic bubbles and then went back 

into Photoshop. With a few adjustments in the 

Scatter and Shape dynamics I added some 

bubbles to the scene.

Now all that was left was the final tweaks, a 

little more light hitting the fish and some color 

dodge on the top of the water where the sun is 

hitting right next to the mother ship. I also added 

a noise filter for some subtle texture and it was 

done (Fig.13)!

I hope you guys enjoyed this underwater 

environment. Of course the way I create the 
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way. For other projects I may do it differently 

but for this they did their job pretty well.

Thanks for reading!

Ioan Dumitrescu
For more from this artist visit:

http://jonone.cgsociety.org/gallery/661127/ 

Or contact them at:

jononespo@yahoo.com

– Free Brushe Images
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Some of you may have seen this great Gediminas Pranckevičius image in the July issue of 2DArtist. 

Well in this issue we get a sneak peek into the processes used to create this quirky image. Gediminas 

uses a 3D base to create a lot of his scene which shows depth and perspective really well.

“I spent a lot of time trying 
to find the correct path and 
almost everything evolved 

in separate pieces”
– Free Brushes

http://www.2dartistmag.com/tutorial_resources/issue_059_nov_2010/makingof01_brushes.zip
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street and buildings. I also used 3D planes to 

construct the road and added boxes instead of 

all small details (Fig.02). In Photoshop I then 

painted some simple small windows (Fig.03) as 

Making Of Wasp Woman 
Returns
Software used: Photoshop and 3D Max

Hello to those who are staring at the monitor at 

the moment. It’s a beautiful day outside right? 

Before we start why don’t we go out and enjoy 

the sun, puffy clouds or even little stars in the 

sky (if its night outside I’d recommend staying 

at home).

I just came back inside and will do my best to 

provide some useful and interesting information 

about my image “The Wasp Woman Returns”. 

This painting was produced for the CGSociety 

competition XXV – B-Movie. I was really 

intrigued by the theme as I was working for a 

cinema at the time and was greatly interested 

in movie posters. Posters from this kind of film 

are really impressive, colorful, and bright, and 

usually have very interesting composition. They 

are also often quite a lot of fun even when they 

should be horrible and scary.

To make it slightly easier for myself I didn’t 

create my own film title, instead I found an old 

poster on the internet and tried to inspire myself 

with it without deviating from the style of the 

period. First of all a few little sketches were 

done to make the composition different to the 

way it was in the original piece (Fig.01). I used 

3ds Max to create realistic perspective in the 

background and help me create the New York 
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a material that can be added and applied to the skyscrapers, shops and 

houses (Fig.04). 

I then created what were soon to be characters. I put them in place 

according to the rules of Divine Proportion (Fig.05). Next I rendered an 

Ambient Occlusion map for the windows (Fig.06) and then the coloring 

started. Mainly I used the Lasso and Gradient tools to apply the color.  

After completing this step I started working on the main attraction: the 

wasp woman. With the Pen tool in Photoshop I carefully traced a photo 
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reference of the face and made a selection and 

filled it with color (Ctrl + Delete). Then, little by 

little with the help of the Pen tool and a Soft 

Round brush, I painted out the shadows and 

added some highlights (Fig.07). The legs of 

the wasp woman, the cars and the frightened 

victims were all done using exactly the same 

workflow.

Even though I tried to work in the right order, 

this was quite a big experiment for me, and I 

spent a lot of time trying to find the correct path. 

Almost everything evolved in separate pieces. 

It is also worth mentioning about first building, 

the one on the right in Fig.08. As it looked quite 

good and the painting around it was also painted 

quite well, I decided to create a more detailed 

model of it in Max. I found a photo reference of 

a building and created a 3D model. When I had 

done that I rendered an Ambient Occlusion map 

and painted it in Photoshop.

One other thing is that I had a lot of fun making 

a custom brush for the body and hair of the 

wasp, I have given this away with the tutorial 

(Fig.09 –10).

Gediminas Pranckevicius
For more from this artist visit:

http://www.gedomenas.com/ 

Or contact them at:

gediminaspr@gmail.com

– Free Brushes
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With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some ex-

clusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-colour, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Portrait of 
Nathan” 
by Jason Seiler



The following shots of the “Portrait of Nathan” book pages are featured here in full-resolution and can be read by zooming in...





View the entire 
Digital Art Masters: Volume 5 book online at

www.3dtotal.com/digitalartmasters_v5

Digital Art Masters is in its  
fifth edition now, and can easily 
be considered one of the best 
showcases of digital artwork 

available today. The quality of the 
artworks, the fine printing and the 
valuable walkthroughs make this 

book a must-have for any art lover 
and for any CG artist, professional 

or beginner.
Alessandro Baldasseroni | www.eklettica.com

Following on from the success of our first four books, we received yet another 
overwhelming response to our call for submissions for Digital Art Masters: Volume 5. Once 
again over 1,100 submissions made their way into the Digital Art Masters mailbox, proving 
to us that the series is becoming ever more popular with not only our readers, but artists 
around the world too!

From this massive number of incredible entries, the 3DTotal team began the difficult task of 
choosing approximately 300 images to take through to the next round. To help in the task, 
we enlisted the help of industry professionals Tim Warnock (matte painter), Till Nowak (3D 
artist) and John Kearney and Chung Wong (videogame artists - VooFoo Studios) to be our 
guest judges. These wonderful artists braved the headaches of a grueling judging process 
and helped the 3DTotal team to select the 50 stunning images that appear in this year’s 
fantastic line-up.

Hardback - 21.6cm x 27.9cm | 304 Full Colour Premium Paper Pages | ISBN: 978-0-240-52171-8

Visit 3DTotal.com to see our full range Book products
3DTOTAL.COM

http://www.3dtotal.com/digitalartmasters_v5/


Available from www.3dtotal.com/shop

Meet some of the finest digital 2D and 3D artists working 
in the industry today – Loïc e338 Zimmermann, Craig 
Sellars, Jelmer Boskma, Maciej Kuciara, Daarken, 
Marek Denko, Kekai Kotaki, Andrew Hickinbottom 
and Marek Okoń. Become inspired by breathtaking 
images, paired with the techniques and tricks of leading 
industry artists

• More than just a gallery book, learn from the best 
digital artists in the world; each artist offers insight 
into how their image was created, with discussions of 
techniques and problem solving solutions

• A source of inspiration for artists of all levels: cutting 
edge imagery showcases the best in today’s digital art

• Featuring more than 50 artists and showcasing over 
900 stunning color images in five sections: Sci-Fi, 
Scene, Fantasy, Character and Cartoon

“Digital Art Masters is getting better and 
better at showcasing some of today’s 
best digital artists. The way the book 
shows the processes of achieving great 
pictures provides a good opportunity to 
learn from these artists, and keeps you 
challenged in your own art.” 

Raphael Lacoste | www.raphael-lacoste.com/

volume 1 volume 2 volume 3
The first book in the 
Digital Art Masters 
series features 48 of 
the finest 2D and 3D 

artists, including Eric 

Wilkerson, Fred Bastide, 

Marcel Baumann, Meny 

Hilsenrad, Natascha 

Roeoesli, Robert Chang 

& Thierry Canon

The second book in the 
Digital Art Masters 
series features 58 of 
the finest 2D and 3D 

artists, including Benita 

Winckler, Glen Angus, 

James Busby, Jonathan 

Simard, Jonny Duddle, 

Philip Straub  & Tae 

Young Choi

The third book in the 
Digital Art Masters 
series features 60 of 
the finest 2D and 3D 

artists, including Damien 

Canderlé, James Paick, 

John Wu, Laurent 

Pierlot, Marc Brunet, 

Mathieu Aerni, Matt 

Dixon & Neil Blevins

http://www.3dtotal.com/books/
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About us  3DTotal

Is a resource website for the CG community; 

amongst our growing number of products for CG 

artists, we produce two monthly downloadable 

PDF magazines – 2DArtist and 3DCreative. 

We are based in the West Midlands, in the UK, 

and our intention with our magazines is to make 

each issue as full of great articles, images, 

interviews and tutorials as possible. If you 

would like more information on 3DTotal or our 

magazines, or if you have a question for one our 

team, please use the links below.

Contact Information
http://www.3dtotal.com

http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Simon Morse 

simon@3dtotal.com 

Lead Designer > Chris Perrins 

chrisp@3dtotal.com 

Marketing > Jo Hargreaves 

jo@3dtotal.com

Partners
If you have a CG community website and would 

like to support 3DCreative and/or 2DArtist 

magazine by showing our banners, please 

contact Simon at the email address above

http://www.2dartistmag.com
http://www.3dtotal.com
http://www.3dcreativemag.com
http://www.2dartistmag.com
mailto:simon@3dtotal.com
mailto:chrisp@3dtotal.com
mailto:jo@3dtotal.com
http://www.epilogue.net/
http://www.cgdirectory.com/
http://www.masteringmentalray.com/
http://news.hiperia3d.com/
http://www.vanishingpoint.biz/
http://www.fallingpixel.com/
http://www.krazybov.com/
http://www.cgpad.org/
http://www.fridgemonsters.com/
http://www.ambiguousarts.com/
http://arttalk.ru/
http://www.inspiring3d.com/
http://www.childplaystudio.com/
http://vainsoftgames.com
http://www.3dhype.com/
http://www.3dm3.com/
http://www.3drevolution.org/
http://www.veegraph.com/
http://www.cgart.ir/
http://www.cgtantra.com
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